Chapter 4

ILWIS objects
Note: This chapter is written as an enhancement to Chapter 4: ILWIS Objects in the
ILWIS 2.1 Reference Guide. It does not completely replace the mentioned
chapter: instead you are invited to use both as one.
Introduction

This chapter only contains those ILWIS objects for which the documentation has
changed. Descriptions are included for the following objects:
§ Data objects:
–
Raster maps
–
Polygon maps
–
Segment maps
–
Point maps
–
Map lists
§ Service objects:
–
Representation
–
Georeferences
–
Coordinate systems
§ Annotation:
–
Annotation Text
–
Simple annotation
For ILWIS objects not described here, refer to the ILWIS 2.1 Reference Guide.
These ILWIS objects are:
§ Data objects:
–
Tables
–
Columns
§ Service objects:
–
Domains
§ Special objects:
–
Map views
–
Histograms
–
Sample sets
–
Two-dimensional tables
–
Matrices
–
Filters
–
Functions
–
Scripts
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4.1

Data objects

4.1.1

Raster maps

A raster map is a data object used to store spatial geographic information and remote
sensing data as pixels (picture elements) of a certain size, e.g. 20 × 20 m. These
pixels are either codified by IDs, class names, values or colors; this is determined by
the domain of the map. The relation between pixels in a raster map and the position
on earth is defined by the georeference that the raster map is using.
Raster maps can be displayed in a map window, and can be edited with the pixel
editor. You can calculate with raster maps (MapCalc) and you can perform many
other raster and image processing operations on them such as: Filter, Cross, Distance
calculation, etc. In ILWIS, most spatial operations are performed on raster maps.
A raster map can be obtained:
§ by importing an existing raster map from ILWIS version 1.41,
§ by rasterizing an existing point, segment, or polygon map,
§ by creating a new raster map and editing its pixels with the pixel editor,
§ by using a satellite image which is already a raster map,
§ by scanning a map or photograph and importing it into ILWIS.
As mentioned above, the output of spatial operations is usually another raster map.
When working with the multi-spectral bands of a satellite image or with multiple
raster map of a time series, you can combine these bands or maps into a map list.
Contents of a raster map and location of pixels
The contents of a raster map are defined by the domain that the raster map is using.
A raster map may store for example:
§ rasterized individual point, segment or polygon features codified by IDs for
instance cadastral plot IDs; the map uses an ID domain,
§ rasterized classes of point, segment, or polygon features codified by class names,
for example land use classes; the map uses a class domain,
§ rasterized point, segment or polygon values for example height values; the map
uses a value domain,
§ reflection values in case of satellite images; the maps use the Image domain, the
NOAA domain, or the Radar domain,
§ true or false pixels; the map uses the Bit domain,
§ true, false or undefined pixels; the map uses a Bool domain,
§ colors in case of a scanned picture that was imported into ILWIS; the map uses a
Picture domain, or the Color domain,
§ output values after a map calculation (any domain),
§ output values (any domain) after performing an operation, e.g. classes after the
Classify operation (image classification), or values after a Distance calculation,
or colors after creating a Color Composite,
§ attribute values (any domain) when an attribute map was created from an
attribute table,
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§ classified values, when a value map was classified (a group domain) with the
Slicing operation.
For more information on domains, refer to Basic concepts : working with domains.
The spatial location of the pixels in a raster map is defined by the georeference that
the raster map is using.
For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. To create an attribute table, refer to How to create an attribute
table.
The manner in which raster maps are displayed is specified in a Display Options
Raster Map dialog box.
§ When a raster map uses a class domain, you can use or create a representation
class. In a representation class, every class has its own color. You can edit the
colors of a representation class in the Representation Class editor, or directly in a
map window by using the Double-click action.
§ When a raster map uses a value domain, you can use or create a representation
value or a representation gradual.
§ Raster maps that are satellite images and use the Image domain, are usually
displayed with system representation Gray; the default stretch range is the 1%
interval.
§ When a raster map uses an ID domain, you can display the map in one single
color or in multiple system colors. However, an ID raster map will usually have
an attribute table and you can then choose to display the map by one of its
attribute columns. For class columns, you can select or create a domain class; for
value columns, you can select or create a representation value or a representation
gradual, etc.
§ When a raster map uses a Bool domain, you can specify colors for True and
False pixels.

F

To store the display setting of one or more maps displayed in a map window, save
the map window as a map view; open the File menu in a map window and choose
the Save View or the Save View As command.
Names of raster maps
Any raster map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a raster map
Usually, you have to rasterize a point, segment or polygon map with the Points to
Raster, Segments to Raster or Polygons to Raster operation. In the Rasterize process,
you have to specify the dimensions of the raster map's pixels in the georeference of
the raster map.
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To display a raster map
The easiest way to display a raster map is to double-click the map in the Catalog.
The map will be displayed in a new map window.
In the Display Options Raster Map dialog box, you can specify how the map should
be displayed.
To edit a raster map
You can edit a raster map by clicking it with the right mouse button in the Catalog
and subsequently choose Edit from the context-sensitive menu. When a raster map is
already displayed in a map window, you can also choose the Edit Layer command
from the Edit menu in the map window. For other methods, see How to edit point,
segment, polygon and raster maps.
Raster maps are edited with the Pixel editor; you can edit the class names, IDs, or
values of the pixels in the raster map. Dependent raster maps and read-only raster
maps cannot be edited.
Operations on raster maps
You can calculate with raster maps by typing a Map Calculation formula on the
command line of the Main window or in the Map Calculation dialog box. When the
definition symbol = is used in a calculation, the output map is dependent.
You can also perform other operations on a raster map by selecting an operation
from the Operation-list or from the Operations menu (for other methods, see How to
start operations). Subsequently, fill out the appearing dialog box of that operation
and click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent.
Advanced users can type the complete ILWIS expressions on the command line of
the Main window or create a script to execute a series of expressions. For more
information, see Appendices: ILWIS expressions.
When the output map of a calculation or another operation uses a value domain, you
can usually define a value range and precision for the output map, see below.
Operations on raster maps are for instance Filter, Cross and Distance calculation.
For more information on operations, refer to ILWIS operations.
Technical information
A raster map consists of an ASCII object definition file (.MPR) and a binary data
file (.MP#). The object definition file contains further references to the domain and
the georeference that the raster map is using; these are properties of a raster map.
By viewing the properties of a raster map, you can see whether the map is dependent
or not, which other objects the map is using, etc. In the properties dialog box of a
value raster map, you can select the Interpolation option to obtain interpolated
values on sub-pixel level. For dependent maps, you can manage dependencies: break
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dependencies, make dependent maps up-to-date, delete the dependent map's data
file, etc.
The IDs, class names or values of pixels are stored line by line, starting from the
first pixel (left) on the first line in the map (up), to the last pixel in the last line.
Raster maps are stored as bit, byte, 2-byte, 4-byte or 8-byte maps. The store type of
a raster map is primarily defined by the domain that the map is using. For value
maps this is determined by the value range and precision that you specify for the
output map during a calculation or operation. Usually, ILWIS will come up with
defaults, but you can adjust these values. Choosing a wide value range and a very
small precision results in a large data file on disk as more bytes are needed to store
each pixel value in the map, also the speed of display and the speed of calculations
may decrease.
For value maps that use 1 or 2 bytes per pixel, the map's histogram is automatically
calculated when you open the map and a histogram is not available yet. For value
maps that are stored using 4 or 8 bytes per pixel, you need to use the Histogram
operation to obtain the map's histogram.
Limitations
The maximum number of lines in a raster map is 2 billion. The maximum number of
columns is 32000 for bit, byte and 2-byte maps, 16000 for 4-byte maps and 8000 for
8-byte maps.

4.1.2

Polygon maps

A polygon map is a data object used to store spatial geographic information that
consists of polygons, i.e. closed areas including the boundaries making up the areas.
The areas are either codified by IDs, class names or values; this is determined by the
domain of the map. The relation between polygons in a polygon map and the
position on earth is defined by the coordinate system that the map is using.
Maps containing uniquely codified areas such as cadastral plots, or mapping units
such as geological formations, land use classes, or soil units, can all be stored as
polygon maps. Polygon maps are usually used as a stepping stone to raster maps.
Polygon maps can be displayed in map windows, and edited with the polygon editor.
A polygon map can be obtained:
§ by importing an existing polygon map from ILWIS version 1.41,
§ by creating a segment map and editing it with the segment editor (with or
without digitizer); then polygonize the segment map either in the segment editor
or with the Segments to Polygons operation,
§ by performing ILWIS operations that return a polygon map as output, for
instance the Attribute map of polygon map operation.
Like in ILWIS 1.4, you first have to digitize segments and then polygonize these
segments to obtain a polygon map.
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Contents of a polygon map and location of polygons
The contents of a polygon map are defined by the domain that the polygon map is
using. A polygon map may store for example:
§ individual area features with or without attributes; each polygon has its own
mostly unique ID, for instance cadastral plot IDs; the map uses an ID domain,
§ classes of area features with or without attributes; polygons may occur in several
places in the map, for instance land use classes or soil classes; the map uses a
class domain,
§ area features representing measurable values; polygon values representing for
instance population densities or concentration levels of air pollution; the map
uses a value domain,
§ true, false or undefined polygons; the map uses a Bool domain,
§ output values (any domain) after performing an operation, e.g. IDs after the
Unique ID operation,
§ attribute values (any domain) when an attribute map was created from an
attribute table with the Attribute map of polygon map operation.
For more information on domains, refer to Basic concepts : working with domains.
The spatial location of polygons in a polygon map is defined by the coordinate
system that the polygon map is using.
For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. When you have for example a map with building blocks
(coded by IDs), you can add an attribute table with the predominant landuse per
building block and the number of residents per building block. Or, when you have a
soil map (coded by classes), you can add an attribute table with pH, soil texture, etc.
for each soil unit.
To create an attribute table, refer to How to create an attribute table.
The manner in which polygon maps are displayed is specified in the Display
Options Polygon Map dialog box.
§ When a polygon map uses a class domain, you can display polygons in a single
color, or by using or creating a representation class. In a representation class,
every class can have its own color, and optionally you can use hatchings or
patterns.
§ When a polygon map uses a value domain, you can display polygons in a single
color or you can use or create a representation value or a representation gradual.
§ When a polygon map uses an ID domain, you can display polygons in a single
color or in multiple system colors. However, an ID polygon map will usually
have an attribute table and you can then choose to display the map by one of its
attribute columns. For class columns, you can select or create a domain class; for
value columns, you can select or create a representation value or a representation
gradual, etc. For more information, see How to display a map by one of its
attributes.
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§ When a polygon map uses a Bool domain, you have to specify colors each time
you display the map.

F

To store the display setting of one or more maps displayed in a map window, save
the map window as a map view; open the File menu in a map window and choose
the Save View or the Save View As command.
Names of polygon maps
Any polygon map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a polygon map
To create a polygon map, you first have to create a segment map in which you can
digitize polygon boundaries. Furthermore, you can create a point map in which you
can digitize the polygon names or IDs as label points. When you display both the
segment and point map in one map window, you can easily see whether the areas
enclosed by segments have a label point. Then, polygonize the segments from within
the segment editor. For more information, refer to How to create polygon maps or to
Segment editor. To check after polygonization whether all polygons obtained a class
name, ID or value, you can use the Polygons to Points operation.
To display a polygon map
The easiest way to display a polygon map is to double-click the map in the Catalog.
The polygon map will be displayed in a new map window. You can also drag a
polygon map from the Catalog to an existing map window, in order to show that
polygon map on top of other information shown in the map window.
In the Display Options Polygon Map dialog box, you can specify how the map
should be displayed.
To edit a polygon map
Class names, IDs, or values of selected polygons can be edited in the polygon editor.
To change the shape of polygons, or to delete or undelete polygon boundaries you
need to use the segment editor; then re-polygonize the segment map.
To open the polygon editor, you can click a polygon map with the right mouse
button in the Catalog and subsequently choose Edit from the context-sensitive menu.
When a polygon map is already displayed in a map window, you can also choose the
Edit Layer command from the Edit menu in the map window. For other methods,
see How to edit point, segment, polygon and raster maps. In the polygon editor, you
can use a digitizer but you can also use the mouse pointer. Dependent polygon maps
and read-only polygon maps cannot be edited.
Operations on polygon maps
The most frequently used operation on polygon maps is probably the Polygons to
Raster operation, which rasterizes a polygon map. During this operation, you have to
select or create a georeference for the raster map to define the size of the pixels in
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the raster map. Another operation on polygon maps is for instance Attribute map of
polygon map.
You can perform operations on a polygon map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions.
For more information on operations, refer to Chapter 7: Operations.
Technical information
A polygon map consists of an ASCII object definition file (.MPA) and a number of
binary data files (.PC#, .PD#, .PL#, .PS#, .TP#). The object definition file contains
further references to the domain and the coordinate system that the polygon map is
using; these are properties of a polygon map.
By viewing the properties of a polygon map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps upto-date, delete the dependent maps's data files, etc.
A polygon map stores one or more polygons. A polygon is nothing more than a list
of XY-coordinate pairs (the polygon boundaries) which form the boundaries of a
polygon. The first and last coordinate pair of a boundary is called a node, so all
individual polygon boundaries are connected to each other by nodes. Each polygon
boundary is used both for the polygon on the left and right of this boundary; this is
called a topological structure. Polygons are identified by IDs, class names or values.
Coordinate pairs are stored as pairs of 2-byte fixed point reals. This means that a
paper map with a size of 3 by 3 meter can be stored with a resolution of 0.1
millimeter on paper. For all practical purposes, this should be enough. Paper maps
smaller than 3 by 3 meters can thus be stored with an even finer resolution. When
you create a map and specify the coordinate boundaries of the map, you should take
care that the boundaries do not exceed this size of 3 by 3 meter on paper.
Limitations
The maximum number of polygons in one polygon map is 32000. The maximum
number of polygon boundaries is 32000. The maximum number of coordinate pairs
in one polygon boundary is 1000 (taken care of by the system).

4.1.3

Segment maps

A segment map is a data object used to store spatial geographic information that
consists of lines, for example roads, rivers or contour lines. Segments are either
codified by IDs, class names or values (height map); this is determined by the
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domain of the map. The relation between segments in a segment map and the
position on earth is defined by the coordinate system that the map is using. Segment
maps can be displayed in map windows, and edited with the segment editor.
A segment map can be obtained:
§ by importing an existing segment map from ILWIS version 1.41,
§ by creating a new segment map and editing it with the segment editor with or
without using a digitizer, or
§ by performing ILWIS operations that return a segment map as output, for
instance the Mask Segments operation.
Contents of a segment map and location of segments
The contents of a segment map are defined by the domain that the segment map is
using. A segment map may store for example:
§ individual line features: each segment is codified by its own ID for instance
when each pipe line or river section has its own unique ID; the map uses an ID
domain,
§ classes of line features: segments may occur in several places in the map for
instance primary roads, secondary roads, etc.; the map uses a class domain,
§ line features representing measurable values, for instance a contour map with
height information; the map uses a value domain,
§ true, false or undefined segments; the map uses a Bool domain,
§ output values (any domain) after performing an operation, e.g. IDs after the
Unique ID operation,
§ attribute values (any domain) when an attribute map was created from an
attribute table with the Attribute map of segment map operation.
For more information on domains, refer to Basic concepts: working with domains.
The spatial location of segments in a segment map is defined by the coordinate
system that the segment map is using.
For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. To create an attribute table, refer to How to create an attribute
table.
The manner in which segments are displayed is specified in the Display Options
Segment Map dialog box.
§ When a segment map uses a class domain, you can display segments in a single
color, or by using or creating a representation class. In a representation class,
every class can have its own line type, line width, color, etc. You can also
represent a line by equally spaced symbols. For more information, see
Representation Class editor and the Edit Repr Class item (segment) dialog box.
§ When a segment map uses a value domain, you can display segments in a single
color, in multiple system colors or by using or creating a representation value or
a representation gradual.
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§ When a segment map uses an ID domain or a Bool domain, you have to specify
colors each time you display the map.
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To store the display setting of one or more maps displayed in a map window, save
the map window as a map view; open the File menu in a map window and choose
the Save View or the Save View As command.
Names of segment maps
Any segment map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a segment map
Open the File menu of the Main window and select the Create Segment Map
command, or double-click the New SegMap item in the Operation-list. In the
appearing Create Segment Map dialog box, enter a name and description for the
segment map, select or create a coordinate system, enter boundary values for the
map and select or create a domain. For other create methods, see How to create a
map.
To display a segment map
The easiest way to display a segment map is to double-click the map in the Catalog.
The map will be displayed in a new map window. You can also drag a segment map
from the Catalog to an existing map window, in order to show that segment map on
top of other information shown in the map window. For other methods, see How to
display maps and tables.
In the Display Options Segment Map dialog box, you can specify how the map
should be displayed.
To edit a segment map
You can edit a segment map by clicking it with the right mouse button in the
Catalog and subsequently choose Edit from the context-sensitive menu. When a
segment map is already displayed in a map window, you can also choose the Edit
Layer command from the Edit menu in the map window. For other methods, see
How to edit point, segment, polygon and raster maps.
Segment maps are edited with the Segment editor: you can insert new segments and
delete and undelete existing ones, edit the class names, IDs, or values of segments,
change the shape of segments, split and merge segments, and pack, check and
polygonize segments. You can use a digitizer but you can also use the mouse
pointer. Dependent segment maps and read-only segment maps cannot be edited.
Operations on segment maps
Frequently used operations on segment maps are for instance the Segments to
Polygons operation to polygonize a segment map and the Segments to Raster
operation, which rasterizes a segment map. During the rasterize operation, you have
to select or create a georeference for the raster map to define the size of the pixels in
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the raster map. Another operation on a segment map is for instance Contour
interpolation.
You can perform operations on a segment map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions.
For more information on operations, refer to Chapter 7: Operations.
Technical information
A segment map consists of an ASCII object definition file (.MPS) and three binary
data files (.CD#, .SC#, .SG#). The object definition file contains further references
to the domain and the coordinate system that the segment map is using; these are
properties of a segment map.
By viewing the properties of a segment map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps upto-date, delete the dependent maps's data files, etc.
A segment map stores one or more segments. A segment is nothing more than a list
of XY-coordinate pairs. Each list of XY-coordinates represents a (part of a) linear
feature. Segments are identified by IDs, class names or values. Places where two or
more segments are connected are called nodes: a node is thus a common XYcoordinate for two or more segments. Further, the beginning and end of a segment
are always nodes.
Coordinate pairs are stored as pairs of 2-byte fixed-point reals. This means that a
paper map with a size of 3 by 3 meter can be stored with a resolution of
0.1 millimeter on paper. For all practical purposes, this should be enough. Paper
maps smaller than 3 by 3 meters can thus be stored with an even finer resolution.
When you create a map and specify the coordinate boundaries of the map, you
should take care that the boundaries do not exceed this size of 3 by 3 meter on paper.
Limitations
The maximum number of segments in one segment map is 32000. The maximum
number of coordinate pairs per segment is 1000 (taken care of by the system).

4.1.4

Point maps

A point map is a data object used to store spatial geographic information which
consists of points, for example water wells or sample points. Points are either
identified by IDs, class names or values; this is determined by the domain of the
map. The relation between points in a point map and the position on earth is defined
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by the coordinate system that the map is using. Point maps can be displayed in map
windows, and edited with the point editor.
A point map is obtained:
§ by importing an existing point map from ILWIS version 1.41,
§ by creating a new point map and editing it with the point editor with or without
using a digitizer,
§ by converting a table which contains coordinate columns to a point map with the
Table to Point map operation, or
§ by performing ILWIS operations that return a point map as output, for instance
the Attribute map of point map operation, or the Segments to Points operation.
Contents of a point map and location of points
The contents of a point map are defined by the domain that the point map is using. A
point map may store for example:
§ individual point features: each point is codified by its own ID, for instance
individual sample points, individual bore holes, individual rainfall stations, etc.;
the map uses an ID domain,
§ classes of point features: points may occur in several places in the map for
instance all water wells of a certain type; the map uses a class domain,
§ point features representing measurable values, for instance height information;
the map uses a value domain,
§ true, false or undefined points; the map uses a Bool domain.
§ output values (any domain) after performing an operation, e.g. IDs after the
Unique ID operation,
§ attribute values (any domain) when an attribute map was created from an
attribute table with the Attribute map of point map operation.
For more information on domains, refer to Basic concepts : working with domains.
The spatial location of points in a point map is defined by the coordinate system that
the point map is using.
For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. When you have for a example a point map with rainfall
stations, coded with IDs, you can add an attribute table with the rainfall figures per
month for each station. To create an attribute table, refer to How to create an
attribute table.
Point symbols
The manner in which points are displayed is specified in the Display Options Point
Map dialog box.
§ When a point map uses a class domain, you can display point symbols as single
symbols or by using or creating a representation class. In a representation class,
every class can have its own symbol, size, color, etc. For more information, see
Representation Class editor and the Edit Repr Class item (point) dialog box.
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§ When a point map uses an ID domain and when the point map has an attribute
table, you can display point symbols as single symbols, as arrows, as graphs or
by attributes. In this way, you can for instance obtain pie charts, bar graphs,
volume cubes, etc. for every point in the map. Sizes, colors, etc. can be specified
by using columns in the attribute table.
§ When a point map uses a value domain, you can choose a symbol set and a
symbol for all the points while the size of the selected symbol may depend on
the value of the points.
§ When a point map uses a Bool domain, you can specify colors for True and
False points.
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To store the display setting of one or more maps displayed in a map window, save
the map window as a map view; open the File menu in a map window and choose
the Save View or the Save View As command.
Names of point maps
Any point map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a point map
Open the File menu of the Main window and select the Create Point Map command,
or double-click the New PntMap item in the Operation-list. In the appearing Create
Point Map dialog box, enter a name and description for the point map, select or
create a coordinate system, enter boundary values for the map and select or create a
domain. For other create methods, see How to create a map.
When you have a table, which contains columns with X- and Y-coordinates, you can
use the Table to Point map operation to obtain a point map from this table.
To display a point map
The easiest way to display a point map is to double-click the map in the Catalog.
The map will be displayed in a new map window. You can also drag a point map
from the Catalog to an existing map window, in order to show that point map on top
of other information shown in the map window. For other methods, see How to
display maps and tables.
In the Display Options Point Map dialog box, you can specify how the map should
be displayed.
Point maps can also be opened as tables: click the point map with the right mouse
button in the Catalog, and subsequently choose Open as Table from the contextsensitive menu. When you display a point map in a table window, you can edit the
XY-coordinates of the points and perform calculations with the XY-coordinates of
the points.

ILWIS 2.2 Guide

49

ILWIS objects

Data objects
To edit a point map
You can edit a point map by clicking it with the right mouse button in the Catalog
and subsequently choose Edit from the context-sensitive menu. When a point map is
already displayed in a map window, you can also choose the Edit Layer command
from the Edit menu in the map window. For other methods, see How to edit point,
segment, polygon and raster maps.
Point maps are edited with the Point editor: you can insert new points and delete
existing ones, edit the class names, IDs, or values of points, and move points to a
new position. You can use a digitizer but you can also use the mouse pointer.
Dependent point maps and read-only point maps cannot be edited.
Operations on point maps
Examples of operations on point maps are for instance point interpolations: moving
average, trend surface, moving surface, or kriging. The point map itself may use a
value domain but you can also use point maps with a class or ID domain and that
have an attribute table, which contains the values, which you want to interpolate.
You can perform operations on a point map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions.
For more information on operations, refer to Chapter 7: Operations.
Technical information
A point map consists of an ASCII object definition file (.MPP) and a binary data file
(.PN#). The object definition file contains further references to the domain and the
coordinate system that the point map is using; these are properties of a point map.
By viewing the properties of a point map, you can see whether the map is dependent
or not, which other objects the map is using, etc. For dependent maps, you can also
manage dependencies: break dependencies, make dependent maps up-to-date, delete
the dependent maps's data files, etc.
Each point is stored as a pair of XY-coordinates. The coordinates pairs are stored as
pairs of 8-byte floating point reals. Points are identified by a class name, ID or a
value.
Limitations
The maximum number of points in a point map is 2 billion.
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Map lists

A map list is a data object and stores the names of a set of raster maps, for example
of the multi-spectral bands of a satellite image that you want to classify. A map list
may also store the names of several raster maps of a time series which you can
display as a slide show. All raster maps in a map list must have the same the same
domain and georeference.
A map list is used:
§ for sampling and image classification,
§ for the creation of interactive color composites,
§ for a principal components analysis or factor analysis,
§ for the calculation of multiband statistics (variance-covariance matrix or
correlation matrix),
§ to present temporal changes in maps; make a time-series by combining several
maps of the same theme but of for instance different years into a map list and
show the map list as a slide show.
Names of map lists
Any map list name must start with a character between A and Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a map list
Open the File menu in the Main window and select the Create Map List command,
or double-click the NewMapList item in the Operation-list, or start an operation
which requires a map list as input and click the create button in the operation's
dialog box. In the appearing Create Map List dialog box, enter a name and
description for the map list, and select the raster maps that together should form the
map list.
To display a map list
A map list is simply a list of raster map names. You can display the individual raster
maps as usual, for instance by double-clicking a raster map in the Catalog; the map
is displayed in a new map window. To open and edit the contents of a map list, see
paragraph To edit a map list.
When your map lists contains raster maps, which have the Image domain or another
value domain, and your graphics board is configured to use more than 256 colors,
e.g. High Color 16-bit or True Color 24-bit, you can display three maps of a map list
as an interactive color composite. Choose Visualization, Show Map List as Color
Composite from the Operations menu and select a map list, or use the right mouse
button on a map list in the Catalog and choose Visualization, as Color Composite
from the context-sensitive menu. You can select the maps of the map lists, which
should be used in the color composite and you can specify the stretch ranges for
each of the selected maps. By changing the display options of the map list, you can
change the color composite. This is very suitable for sampling and on-screen
digitizing. For more information, refer to How to create a color composite.
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Furthermore, all maps in a map list can be displayed one after the other in one map
window, as a slide show. This is very suitable to display a time series. Choose
Visualization, Show Map List as Slide Show from the Operations menu, or use the
right mouse button on a map list in the Catalog and choose Visualization, as Slide
Show from the context-sensitive menu. For more information on slide shows, see
How to display a map list as a slide show or Map window: advanced functionality.
To edit a map list
To edit a map list, select Edit Object from the Edit menu in the Main window and
select a map list, or use the right mouse button on a map list in the Catalog and
choose Edit from the context-sensitive menu. In the appearing Edit Map List dialog
box you can change the selection of raster maps that are included in the map list. See
also How to edit a map list.
Operations on map lists
Usually, you will create a map list during sampling to obtain a sample set with
which you can perform a supervised classification in a later stage. Sampling
however is an interactive process and not a genuine operation.
Operations on a map list return multivariate statistical information (a matrix) on the
values of the different raster maps in a map list. Only the Principal Components and
Factor Analysis operations result in an output map list.
You can start an operation on a map list for instance by selecting an operation from
the Operation-list or from the Operations menu. For other methods, see How to start
operations. Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output matrices and output raster maps that are obtained through an operation's
dialog box are always dependent; however output map lists are not dependent yet.
Advanced users can type the complete ILWIS expressions on the command line of
the Main window or create a script to execute a series of expressions.
Technical information
A map list consists only of an ASCII object definition file (.MPL). The object
definition file contains further references to raster maps that are included in the map
list.
By viewing the properties of a map list, you can see the size of the object and the
time it was last changed. In case you calculated a variance-covariance matrix or a
correlation matrix, the properties dialog box contains an extra button Additional
Info, which shows you the Optimum Index Factor (OIF) of combinations of three
bands in the map list. For more information, see How to calculate the Optimum
Index Factor.
Limitations
In principle, the maximum number of raster maps that can be included in a map list
is 5440. In practice however limitations will occur by memory and available disk
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space. For operations that result in a matrix, a map list cannot contain more than 80
raster maps.

4.2

Service objects

4.2.1

Representations

A representation defines the manner in which classes of a map with a class domain,
a group domain or a picture domain, or the values of a map with a value domain or
the image domain should be represented on the screen and on a printer.
A representation stores colors or ranges of colors for the classes in a class domain,
or for specific values or ranges of values for the values in a value domain.
Furthermore, for polygon classes, colors, hatching and patterns can be stored; for
segment classes, colors, line types and line widths, etc. can be stored; and for point
classes, colors, symbols, symbol sizes, etc. can be stored.
A representation is a service object for a domain, i.e. a domain uses a certain
representation.
Maps with a Bool, the Bit, an ID, or the Color domain do not have a stored
representation on disk:
§ For maps with a Bool domain or the Bit domain, you can interactively select
colors in the Display Options dialog box of the map each time you display the
map.
§ Maps with an ID domain can be shown in 7, 15, or 31 colors to inspect the map
itself. In most cases however, you will display an ID map by one of its attributes
as stored in the map's attribute table; to do so, select the Attribute check box in
the Display Options dialog box of the ID map and select an attribute column.
§ Raster maps with the Color domain store colors in each pixel, so no
representation is needed.
Furthermore, special options for point symbols available in the Display Options
dialog box of a point map.
F

You can always create a number of representations for a certain domain, for
instance by clicking the create button next to the Representation list box in the
Display Options dialog box of a map. Then, to display the map with a certain
representation, in the map's Display Options dialog box, select the representation
you want to use.
Types of representations
There are three types of representations:
§ representation class: for the classes in a class domain, the groups a group
domain, or the items in a picture domain. For each class in the domain, a
representation class contains: colors for mapping units in raster maps; colors,
hatching or patterns for polygons; colors, line types, line widths, etc. or equally
spaced symbols for segments; colors, symbol type, symbol sizes, etc. for points.
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§ representation gradual: defines colors for ranges of values (as percentages) in
a value map. Any map with a value domain can be displayed with an existing
representation gradual. Maps, which use system domain Value, can only be
displayed with a representation gradual; you can also create a representation
gradual for such maps. Examples of a representation gradual are Gray and
Pseudo. To change the domain of a map, which uses system domain Value to a
user-defined value domain, in order to create a representation value, see How to
change the domain of maps.
§ representation value: defines colors for ranges of values (as values) in a value
map. A representation value can be created for maps with the Image domain
(interactive slicing), for maps with a user-defined value domain (e.g. a Height
domain), and for maps with a system value domain except system domain
Value. You can create various value representations for individual value
domains.
General use of representations
§ All maps which use the same class domain (e.g. Landuse) will by default use
the same representation class: these maps will thus by default be displayed in the
same colors. You can also create or select another representation class, which
fits the classes in the domain.
§ All maps which use the same value domain (e.g. Height) will by default use
the same representation value: these maps will thus by default be displayed in
the same colors. Except for maps, which use system domain Value, you can
also create or select another representation value, which fits this domain.
Furthermore, you can select a representation gradual e.g. Pseudo.
§ Maps, which use the system domain Value, can only be shown in a
representation gradual. You can select any existing representation gradual, or
create your own representation gradual.
Names of representations
Any representation name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

F
F

To show representations in the Catalog, refer to How to customize the Catalog.
To view which representation is linked to a certain domain, check the properties of
the domain.
To create a representation
1. Creating a representation class:
When creating a new class or group domain, a representation class is
automatically created with default colors; these can of course be edited.
The easiest way to create another representation class for a map with a class,
group or picture domain, is to click the create button in the Display Options
dialog box of the map. Then a new representation class is created for the domain
that is used by the map.
The Representation Class editor will be opened.
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In the Representation Class editor, choose whether you want to adapt the
representation for the raster form, the polygon form, the segment form or the
point form. Then, edit the colors, etc. of each class for instance by doubleclicking individual classes. You can also select multiple classes and choose Edit
Multiple Items from the Edit menu to assign one color or a smooth range of
colors to the selected classes.
2. Creating a representation value:
When creating a new value domain, a representation value is not automatically
created. You can always show a map with a value domain with an existing
representation gradual, e.g. Pseudo.
The easiest way to create a representation value for a map with a value domain
(except the system domain Value) is to click the create button in the Display
Options dialog box of the map. Then a new representation value is created for
the domain that is used by the map. The Representation Value/Gradual editor
will be opened.
In the Representation Value/Gradual editor, you can insert limits, i.e. boundary
values for a representation value, you can choose or create a color for each limit,
and you can indicate whether to stretch between the limits or to use the color of
the upper of lower boundary.
3. Creating a representation gradual:
When you click the create button in the Display Options dialog box of a map
which uses the system domain Value, a new representation gradual is created
with default colors. Furthermore, a representation gradual will be created when
you select system domain Value in the Create Representation dialog box. The
Representation Value/Gradual editor is opened.
In the Representation Value/Gradual editor, you can insert limits, i.e. boundary
percentages for a representation gradual, you can choose or create a color for
each limit, and you can indicate whether to stretch between the limits or to use
the color of the upper of lower boundary.
When a map (e.g. Map1) is currently using system domain Value, and thus a
representation gradual, and you want to use a representation value instead, you
have to change the domain of the map with system domain Value to a userdefined domain:
–
Perform a simple mapcalc statement like Map2 = Map1;
–
Create a new value domain in the Raster Map Definition dialog box by
clicking the create domain button;
–
Then display Map2 and in the map's Display Options dialog box, click the
create representation button. You have created a representation value and you
can assign colors to specific values in the map.
For more information, see How to change the domain of a map.
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4. Other ways to create representations:
Furthermore, you can create a representation through the File menu of the Main
window, by double-clicking the New Repr item in the Operation-list, or via the
Properties dialog box of a domain. For more information, see How to create a
representation.
To view and edit a representation
To edit an existing representation, you can for instance double-click a representation
in the Catalog. When a map is displayed in a map window, you can also open the
Edit menu in the map window and choose Representation. Depending on the type of
representation you selected, the Representation Class editor or the Representation
Value/Gradual editor is opened. For more information, see How to edit a
representation or the respective editors.
Advanced users may wish to open and/or edit a representation class as a table. For
more information, see How to open objects as a table. System representations and
read-only representations cannot be edited.
Technical information
A representation consists of an ASCII object definition file (.RPR); in case of a
representation class also a binary data file (.RP#) is available. The object definition
file has no further references to other objects.
By viewing the properties of a representation, you can see for instance the type of
the representation and you can find out to which domain the representation is linked.
A representation is a property of a domain.
A representation class stores, for each class in the domain:
§ a color (raster form);
§ a color, hatching or pattern (polygon form);
§ a color, a line type (e.g. single, double, triple, dot, dash dot, blocked), line width,
optional support line, optional background color for the support line, and a
symbol font and a symbol when a line should be represented by symbols
(segment form);
§ symbol type, symbol, size, line width, color, fill color, rotation (point form).
Advanced users may wish to open and edit a representation class as a table.
A representation gradual stores:
§ limits, i.e. boundary values as percentages of the values in the domain,
§ a color for each limit,
§ for each range of percentages in between two limits, whether to stretch colors or
to use the color of the upper of lower boundary (slice), and
§ when you stretch the colors in between two limits: the number of steps to be
used for stretching.
A representation value stores:
§ limits, i.e. boundary values as values of the domain,
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§ a color for each limit,
§ for each range of values in between two limits, whether to stretch colors or to
use the color of the upper of lower boundary (slice), and
§ when you stretch the colors in between two limits: the number of steps to be
used for stretching.
System representations
The following system representations are representations gradual:
Blue
From black to blue in 16 stretch steps.
Clrstp6
Six times from black to a color (6 colors between blue to red), each
time in 8 stretch steps.
Clrstp8
Eight times from black to a color (8 colors between blue to red), each
time in 8 stretch steps.
Clrstp10
Ten times from black to a color (10 colors between blue to red), each
time in 8 stretch steps.
Clrstp12
Twelve times from black to a color (12 colors between blue to red),
each time in 8 stretch steps.
Cyan
From black to cyan in 16 stretch steps.
FineGray
From black to white in 60 stretch steps.
Gray
From black to white in 30 stretch steps.
Green
From black to green in 16 stretch steps.
Inverse
From white to black in 30 stretch steps.
Magenta
From black to magenta in 16 stretch steps.
Pseudo
From blue to green to red in 6 x 9 stretch steps.
Red
From black to red in 16 stretch steps.
Yellow
From black to yellow in 16 stretch steps.
There is one system representation class available:
ColorCmp
Designed for output raster maps of the Color Composite operation
created with the Standard option; 216 colors.
4.2.2

Georeferences

A georeference defines the relation between rows and columns in a raster map and
XY-coordinates. The location of pixels in a raster map is thus defined by a
georeference. It is advised that raster maps of the same area use the same
georeference. A georeference uses a coordinate system, which may contain
projection information. Polygon, segment and point maps merely use a coordinate
system. A georeference is a service object, usually for several raster maps.
Georeference types
There are five main types of georeferences:
§ georeference corners: a North-oriented georeference to be used during
rasterization of vector data or as the North-oriented georeference to which you
want to resample maps;
§ georeference tiepoints: a non-North-oriented georeference to add coordinates to
a satellite image or to a scanned photograph, a scanned map, etc. without using a
DTM;
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§ georeference direct linear: to add coordinates to a scanned photograph while
using a DTM;
§ georeference orthophoto: to add coordinates to a scanned aerial photograph
while using a DTM and camera parameters;
§ georeference 3D: to create a three dimensional view of maps.

F

For a correct behaviour of a georef direct linear, and a georef orthophoto, it is
essential that you have marked the 'Interpolation' check box in the Properties dialog
box of your DTM raster map. For more information, refer to the Raster Map
Properties dialog box.
Furthermore, system georeference None is available for raster maps that do not have
coordinates.
Other types of georeferences are obtained when performing an operation on raster
maps:
§ georeference factor: created by the Aggregate map and the Densify operation;
§ georeference mirrorrotate: created by the MirrorRotate operation;
§ georeference submap: created by the Sub-map of raster map and the Glue raster
maps operation.
General use of georeferences
When a raster map has a georeference, you can:
§ inspect coordinates at the position of the mouse pointer in a map window, at the
status line;
§ retrieve information at the position of the mouse pointer in a map window from
other maps, i.e. functionality of the pixel information window;
§ inspect the pixel size of raster maps in meters;
§ check if raster maps fit on top of each other (requirement for MapCalc and
Cross);
§ overlay vector data on raster maps;
§ rasterize vector data to raster maps;
§ resample raster data which uses a particular georeference to another
georeference; create an orthophoto from a scanned aerial photograph which has
a georef orthophoto by resampling it to a georef corners;
§ screen digitize on satellite images or on scanned photographs which have a
georef tiepoints; screen digitize on scanned photographs which have a georef
direct linear; monoplot on scanned aerial photographs which have a georef
orthophoto.
A map window also uses a georeference. When the map window displays a raster
map, this is the georeference of the raster map. When a map window only displays
vector data, an internal georeference is used that is created from the coordinate
system and coordinate boundaries of the vector maps.
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Names of georeferences
Any georeference name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
F
F

To show georeferences in the Catalog, refer to How to customize the Catalog.
To view which georeference is used by a raster map, check the properties of the
raster map.
To create a georeference
A georeference can be created:
§ during rasterization, click the create georeference button in a Rasterize dialog
box; the Create Georeference Corners dialog box will appear; you can create a
georef corners.
§ when a satellite image, a scanned photograph, or a scanned map is displayed in a
map window, choose the Create Georeference command from the File menu of
the map window; the Create Georeference (in map window) will appear; you can
create a georef tiepoints, a georef direct linear or a georef orthophoto.
§ when you want to create a 3D view of your study area, start the Display 3D
operation, and click the create georeference button in the dialog box; the Create
Georeference 3D dialog box will appear; you can create a georef 3D.
Other general ways to create a georeference are:
§ by choosing the Create Georeference command on the File menu of the Main
window,
§ by double-clicking the New Georef item in the Operation-list,
§ by opening the Properties dialog box of a raster map: click the Edit button in the
Properties dialog box and click the create button in the subsequent Edit
Properties dialog box.
For more information, refer to How to create a georeference, How to add
coordinates to an image, How to screen digitize, How to monoplot, How to create an
orthophoto or How to create a 3D view.
To view or edit a georeference
You can view and edit a georef corners, a georef tiepoints, a georef directlinear, a
georef orthophoto and a georef 3D. The easiest way to edit a georeference is to
double-click a georeference in the Catalog. When a raster map, which has a
georeference is displayed in a map window, you can also open the Edit menu in the
map window and choose Georeference.
Depending on the type of georeference you open (or the georeference which is used
by the raster map in the map window), a dialog box will appear or an appropriate
editor will be opened:
§ for a georef corners: the Edit Georeference Corners dialog box will appear;
§ for a georef tiepoints, a georef direct linear, or a georef orthophoto: the
Tiepoint editor will be opened. When editing a georef orthophoto, the Locate
Fiducial Marks dialog box will appear first;
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§ for a georef 3D: the Display Options - 3D Grid dialog box appears, in which you
can specifying how the 3D view should be displayed in the map window. When
the 3D view is displayed in a map window, you can select the Georeference
command from the Edit menu of the map window to edit the georeference 3D.
The Georeference 3D editor is started.
A georef factor, a georef mirrorrotate or a georef submap cannot be edited.
Information on these georeferences can be found in their properties dialog box.
Advanced users may wish to open a georef tiepoints, a georef directlinear or a georef
orthophoto as a table.

F

To have a raster map use another georeference than its current one, perform the
Resample operation.
Technical information
A georeference consists of an ASCII object definition file (.GRF); in case of a
georef tiepoints, a georef direct linear or a georef orthophoto, also a binary data file
(.GR#) is available. The object definition file contains further references to:
§ the coordinate system that is used by the georeference;
§ in case of a georef tiepoints, georef direct linear or a georef orthophoto, the
background map on which tiepoints are positioned;
§ in case of a georef direct linear or a georef orthophoto, the DTM from which
height values should be obtained.
These are properties of a georeference.
By viewing the properties of a georeference, you can see for instance the type of the
georeference and find out which raster maps are using this georeference. By clicking
the Additional Info button in the properties dialog box of a georef tiepoints, a georef
direct linear or a georef orthophoto, you will get extra information on transformation
or orientation results.
The system georeference None is available for raster maps that do not have
coordinates.
Georeference corners:
Stores minimum and maximum XY-coordinates, and whether these refer to the
corners of the corner pixels or to the centers of the corner pixels.
Col = a1 X + b1
Row = a2 Y + b2
- Georeference tiepoints:
Stores a set of tiepoints in RowCol and XY-coordinates and a transformation
method. Parameters are found by a least squares method. Height values are
not taken into account. Available transformation methods and their formulas
are:
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- Conformal:
minimum of two tiepoints required;
Col = aX + bY + c1
Row = bX - aY + c2
- Affine:
recommended for satellite images; minimum of three tiepoints required;
Col = a11X + a12Y + b1
Row = a12X + a22Y + b2
- Second order bilinear: minimum of 4 tiepoints required;
Col = a1 + b1X + c1Y + d1XY
Row = a2 + b2X + c2Y + d2XY
- Full second order: minimum of 6 tiepoints required;
Col = a1 + b1X + c1Y + d1XY + e1X² + f1Y²
Row = a2 + b2X + c2Y + d2XY + e2X² + f2Y²
- Third order: minimum of 10 tiepoints required;
Col = a1 + b1X + c1Y + d1XY + e1X² + f1Y² + g1X³ +
h1X²Y + i1XY² + j1Y³
Row = a2 + b2X + c2Y + d2XY + e2X² + f2Y² + g2X³ +
h2X²Y + i2XY² + j2Y³
- Projective:
recommended for normal camera, i.e. small format, photographs;
conventional rectification; minimum of 4 tiepoints required;
Col = (aX + bY + c) / (gX + hY +1)
Row = (dX + eY + f) / (gX + hY + 1)
- Georeference DirectLinear:
Recommended for normal camera, i.e. small format, photographs when a
DTM is available; also corrects for tilt and relief displacement; Direct Linear
Transformation (DLT). Stores a set of tiepoints in RowCol and XYZcoordinates. Height values can be supplied by the user, otherwise these are
obtained from the DTM. Orientation parameters, i.e. camera position (X0, Y0,
Z0) and angles (κ, ϕ, ω), are calculated from the tiepoints. Minimum of 6
tiepoints required; tiepoints must not be co-planar, i.e. the tiepoints should not
be on a (tilted) plane.
- Georeference OrthoPhoto:
Recommended for photogrammetric camera aerial photographs when a DTM
is available; also corrects for tilt and relief displacement; Differential
rectification. Stores fiducial marks, principal distance, and a set of tiepoints in
RowCol and XYZ-coordinates. Height values can be supplied by the user,
otherwise these are obtained from the DTM. The user needs to specify
fiducial marks and principal distance; orientation parameters, i.e. camera
position (X0, Y0, Z0) and angles (κ, ϕ, ω), are calculated from the tiepoints
(outer orientation). Minimum of 3 tiepoints required.
- Georeference 3D:
Stores a number of 3D view parameters: view point, location height, scale
height, horizontal and vertical rotation, distance, view angle.
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- Georeference factor:
Stores a factor of the pixel size of another raster map and horizontal and
vertical offset of another raster map.
- Georeference mirrorrotate:
Stores whether another georeference is mirrored horizontally, vertically,
diagonally or is transposed, or rotated 90°, 180°, or 270°.
- Georeference submap:
Stores offset and size related to another georeference.

4.2.3

Coordinate system

A coordinate system contains information on the kind of coordinates you are using
in your maps; you may for instance use user-defined coordinates, coordinates
defined by a national standard or coordinates of a certain UTM zone. A coordinate
system defines the possible XY- or LatLon-coordinates that can be used in your
maps.
Point, segment and polygon maps always have a coordinate system. Raster maps
have a georeference, which uses a coordinate system. A coordinate system is a
service object for point, segment and polygon maps, and for georeferences of raster
maps.
In ILWIS, XY-coordinates are supposed to be in meters and the 90° angle between
the positive X-axis and the positive Y-axis is counter-clockwise.
Coordinate system types
There are five main types of coordinate systems:
§ coordinate system boundary only: to define XY-coordinates for maps by only
specifying the boundaries of your study area. This type of coordinate system
should only be used when you are sure that you will not use projections at all;
furthermore, maps using a coordinate system boundary only, cannot be
transformed into any other coordinate system.
§ coordinate system projection: to define XY-coordinates for maps by specifying
the boundaries of your study area and when you want to have the possibility to
add projection information, ellipsoid information and/or datum information. You
can add the projection information later on or right away. Maps with different
coordinate systems and different projections can be transformed into one
another.
§ coordinate system latlon: to define LatLon-coordinates for maps by specifying
the boundaries of your study area in Latitudes and Longitudes and when you
want to have the possibility to add ellipsoid information and/or datum
information. You can add the ellipsoid information and/or datum information
later on or right away.
§ coordinate system formula: when you obtained data which is using different
XY-coordinates than the coordinate system of your project, and when you know
the relation between the two coordinate systems. You can create a coordinate
system formula for maps with artificial coordinates, i.e. starting at (0,0) or
digitized in millimeters. The coordinate system formula uses a 'related'
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coordinate system; this is the coordinate system with correct coordinates. When
you have defined the formula and when the map with artificial coordinates uses
the newly created coordinate system formula, then you can transform the map to
the correct coordinate system.
§ coordinate system tiepoints: when you obtained data which is using different
XY-coordinates than the coordinate system of your project, and when you do not
know the relation between the two coordinate systems. You can create a
coordinate system tiepoints for maps with artificial coordinates, i.e. starting at
(0,0) or digitized in millimeters. The coordinate system tiepoints uses a 'related'
coordinate system; this is the coordinate system with correct coordinates. When
you have specified the tiepoints and transformation method, and when the map
with artificial coordinates uses the newly created coordinate system tiepoints,
then you can transform the map to the correct coordinate system.
Furthermore, two coordinate systems are available in the \SYSTEM directory:
§ coordinate system Unknown: when you do not care about coordinates.
§ coordinate system LatLon: when you obtained raster or vector data which are
supposed to use LatLon-coordinates on a sphere (world-wide).
General use of coordinate systems
§ For general analysis purposes, it is advised to use one coordinate system for all
your maps. This coordinate system should be wide enough to cover all X- and
Y-coordinates that should be stored in your maps.
§ Coordinate systems enable you to transform vector maps from one coordinate
system to the other. There are 3 possibilities:
–
When maps use a coordinate system projection or a coordinate system latlon
and when this coordinate system actually contains projection, ellipsoid or
datum information, then you can transform the map to any other coordinate
system of type projection or latlon which contains projection, ellipsoid or
datum information.
–
When maps use a coordinate system formula (which uses a related
coordinate system with correct coordinates), then you can transform the map
to the related coordinate system.
–
When maps use a coordinate system tiepoints (which uses a related
coordinate system with correct coordinates), then you can transform the map
to the related coordinate system.
§ A map window has the capability to transform vector maps on the fly or
temporarily. When a point, segment or polygon map with a certain coordinate
system is displayed in a map window, you can drag or add another coordinate
system to the map window. If a transformation between both coordinate systems
is possible, the map window will use the newly added coordinate system; the
vector maps displayed by the map window will be shown in the new coordinate
system, i.e. the maps are temporarily transformed.
§ When you use pixel information and the map is currently using one coordinate
system, you can add another coordinate system to the pixel info window. When
a transformation is possible between both coordinate systems, the pixel
information window will also show you the coordinates in the new coordinate
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system. The pixel information window can also retrieve information from maps
with another 'transformable' coordinate system.
§ The following maps can be displayed with a graticule:
–
maps which use a coordinate system projection with a projection,
–
maps which use a coordinate system latlon,
–
maps which use a coordinate system formula, where the related coordsys is a
coordsys projection with a projection or a coordsys latlon,
–
maps which use a coordinate system tiepoints, where the related coordsys is
a coordsys projection with a projection or a coordsys latlon.
§ When resampling raster maps from one georeference to another georeference,
which uses another coordinate system, then a transformation is automatically
performed.

F

When you receive data in different projections (and you have created correct
coordinate systems with correct projections for these maps), it is advised to use the
Transform operations to transform vector data from the current coordinate system
into one other coordinate system, or to use the Resample operation to resample
pixels of a raster map the current georeference into one other georeference (with
another coordinate system).
Names of coordinate systems
Any coordinate system name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
To create a coordinate system
To create a coordinate system, you can select the Create Coordinate System
command on the File menu of the Main window or double-click the NewCrdSys
item in the Operation-list. The Create Coordinate System dialog box will appear:
you can create any type of coordinate system.
When one or more vector maps which do not have correct coordinates yet are
displayed in a map window, you can also select the Create Coordinate System
command on the File menu of the map window. The Create Coordinate System (in
map window) dialog box will appear: you can create a coordinate system formula or
a coordinate system tiepoints.
Other ways to create a coordinate system are:
§ by clicking the create button in the dialog box when creating a point, segment or
polygon map, or a georeference,
§ by opening the Properties dialog box of a vector map: click the Edit button in the
Properties dialog box and click the create button in the subsequent Edit
Properties dialog box.
For more information, refer to the Create Coordinate System dialog box. It is
advised that within one project, all maps use the same coordinate system.
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To view or edit a coordinate system
The easiest way to view and/or edit an existing coordinate system, is to double-click
a coordinate system in the Catalog. When one or more raster and/or vector maps are
displayed in a map window, you can also open the Edit menu in the map window
and choose Coordinate System.
Depending on the type of coordinate system you open (or the type of coordinate
system that is currently used by the map window), a dialog box will appear or an
appropriate editor will be opened:
§ for a coordsys boundary only: the Edit Coordinate System Boundary Only
dialog box will appear;
§ for a coordsys projection: the Edit Coordinate System Projection dialog box
will appear;
§ for a coordsys latlon: the Edit Coordinate System LatLon dialog box will
appear;
§ for a coordsys formula: the Edit Coordinate System Formula dialog box will
appear;
§ for a coordsys tiepoints: the Coordinate System Tiepoints editor will be opened.
Of course, to open and edit a coordinate system, you can also click a coordinate
system with the right mouse button in the Catalog and choose Open from the
context-sensitive menu, use the Edit Object command on the Edit menu in the Main
window, double-click the Edit item in the Operation-list, etc.
F
F
F

To show coordinate systems in the Catalog, refer to How to customize the Catalog.
To view which coordinate system is used by a georeference of a raster map or by a
point, segment or polygon map, check the properties of a georeference or the
properties of a point, segment or polygon map.
Advanced users may wish to open a coordinate system tiepoints as a table.
Technical information
A coordinate system consists of an ASCII object definition file (.CSY); in case of a
coordsys tiepoints also a binary data file (.CS#) is available. The object definition
file stores the coordinate boundaries and, if available, projection information, a
formula, etc.
By viewing the properties of a coordinate system, you can see for instance the type
of the coordinate system, the boundary coordinates of the coordinate system, and
find out by which vector maps and by which georeferences this coordinate system is
used. For a coordinate system formula and a coordinate system tiepoints, also the
related coordinate system is listed. Furthermore, for a coordinate system tiepoints,
you can find the transformation results by clicking the Additional Info button.

Introduction on Projections

A projection defines the relation between the map coordinates (X,Y) and the
geographic coordinates latitude and longitude (ϕ, λ).
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The Earth's surface is curved, however in maps it is presented as a flat surface.
Therefore, the display of an area on a map will always lead to some deformation or
distortion; there is no 'perfect' projection. If you show only a small part of the Earth,
like a town, the distortion will be almost insignificant. If, on the other hand, a map
shows a continent, deformations and distortions will be a major problem. To
correctly represent the curved Earth's surface on a flat map, you need a special
projection. The geographic coordinates are converted to a metric coordinate system,
measuring the X- and Y-directions in meters. Each projection has unique equations
for the transformation from geographic to metric coordinates.
Because of the earth's rotation, the shape of the earth is not a perfect sphere. The
earth is flattened towards the poles: the equatorial axis (line from the center to the
Equator) is longer than the polar axis. The shape of the earth can be represented by
an ellipsoid, or as it is sometimes called, a spheroid (shapes that are generated by
revolving an ellipsis around its minor axis). The choice of the ellipsoid which fits
best a certain region of the earth surface to be mapped depends on the surface
curvature and undulations in that region. Hence every country has its own 'best fit'
ellipsoid.
General characteristics of projections

Projection types
Based on the shape of the projection surface, one can classify the projections in
azimuthal, conical and cylindrical projections. Therefore, the cone or cylinder needs
to be 'unrolled' to form a plane map.
1. Cylindrical projections
Cylindrical projections may be imagined as the projection to a plane that is
wrapped around the globe in the form of a cylinder (see Figure 1). After
unrolling, the outline of the world map would be rectangular in shape; the
meridians are parallel straight lines which cross at right angles by straight
parallel lines of latitude. Examples: Mercator, Plate Carree.

Figure 1: Principle of cylindrical projections.

2. Azimuthal projections
Azimuthal projections may be imagined as the projection on a plane tangent to
the globe (Figure 2). The characteristic outline of the world map would be
circular. If the pole is the central point, the meridians are straight lines, spaced at
66

ILWIS 2.2 Guide

Service objects

ILWIS objects
their true angles intersecting at this center point. Parallels are represented as
concentric circles. Examples: Gnomonic, Stereographic.

Figure 2: Principle of azimuthal projections.

3. Conical projections
Conical projections may be imagined as the projection to a plane that is wrapped
like a cone around the globe (Figure 3). After unrolling the outline of the world
would be fan shaped. The meridians are represented as straight lines and
parallels as concentric circles. Only the parallels where the cone touches the
globe have the same length as on earth.

Figure 3: Principle of conical projections.

Aspect
Furthermore, projections can be subdivided according to the direction in which a
cylinder, plane or cone is oriented with respect to the globe, the so-called aspect. In
the text above, it is assumed that the projection only touches the Earth. However, it
is also possible to use a secant cylinder, plane or cone, which intersects the sphere.
Figures 4, 5, and 6 show some aspect types for different types of projections.
§ For cylindrical projections a normal aspect is a cylinder that touches the equator.
A transverse aspect is a cylinder that touches the poles.
§ Similarly the normal and secant aspects of azimuthal projections can be
visualized.
§ The aspect may also be oblique; in that case the cylinder, plane or cone is not
horizontally or vertically oriented, but something in between.
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Figure 4: Different aspects for cylindrical projections.

Figure 5: Different aspects for
azimuthal projections.

Figure 6: Different aspects for
conical projections.

Projection characteristics
As mentioned before a map projection always results in some deformation or
distortion. Depending on the type of projection, these distortions will be different.
This is indicated by the characteristics of a projection:
§ Conformality: a conformal map is one in which all angles are indicated
correctly. Angles between two points in a map with a conformal projection and
between two points on Earth are the same. As all angles are maintained, the
shape of the objects is also preserved. Examples: Mercator, Stereographic.
§ Equivalence: a map with an equivalence property is an equal-area map.
Although the shape of objects is distorted, the areas of all regions are shown in
the same proportion to their true areas. Examples: Mollweide, Sinusoidal.
§ Equidistance: an equidistance map has the characteristic that in one direction the
distances are preserved.
Available projections
Map projections are named according to the class, the aspect, the property, the name
of the originator and the nature of any modification. For an overview of available
projections, refer to the Select Projection dialog box. For hints on what projection to
use, refer to Suggested projections.
Coordinate system Formula

You can create a coordinate system formula for maps with artificial coordinates, i.e.
starting at (0,0) or digitized in millimeters. The coordinate system formula uses a
'related' coordinate system; this is the coordinate system with correct coordinates.
When you have defined the formula and when the map with artificial coordinates
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uses the newly created coordinate system formula, then you can transform the map
to the correct coordinate system.
Transformation formulae:
x
In the formulae below,   is used for the related coordinates,
 y

 X out 

 for the
 Yout 

x 
coordinates of the coordsys formula which you are creating,  0  for the origin in
 y0 
X 
the related coordsys, and  0  for the origin of the coordsys formula which you
 Y0 
are creating.
Conformal:
 X out 
 cos ϕ sin ϕ   x − x 0   X 0 

 = k 

 + 
 
 − sin ϕ cos ϕ   y − y 0   Y0 
 Yout 
k = scaling
ϕ = rotation
Differential scaling:
 X out   k 1 0   x − x 0   X 0 

 = 

 + 
 
 Yout   0 k 2   y − y 0   Y0 
k1 = X-scaling
k2 = Y-scaling
Skew along X-axis:
 X out   1 tan α
 = 

1
 Yout   0
α = skew

 x − x0  X0 

 + 
 
  y − y 0   Y0 

 X out   1
 = 

 Yout   tan β
β = skew

 x − x0  X0 

 + 
 
  y − y 0   Y0 

Skew along Y-axis:
0
1

Affine:
 X out   a 11 a12   x − x 0   X 0 

 + 
 
 = 

 Yout   a 21 a 22   y − y 0   Y0 
a11, a12, a21, a22 = matrix coefficients
User-defined expression:
Xout = fx (x - x0, y - y0) + X0
Yout = fy (x - x0, y - y0) + Y0
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4.3.1

Annotation Text

An Annotation Text object, also called an annotation text layer, is designed to
display and store multiple texts at multiple positions. While simple annotation types
can only be stored by saving a map window as a map view, an Annotation Text
object can be stored itself.
When creating an Annotation text object, you can base the texts that will appear in
the text object on an existing point, segment, or polygon map. If you do so, the text
object will contain a text (class name, ID or value) for each point, segment or
polygon in the selected map.
An Annotation Text object can be edited with the Annotation Text editor or in a
table window. In the Annotation Text editor, you can easily insert more text items,
change and refine the position of texts (move), make text duplicates, and specify
fonts, font sizes, appearance (bold, italics, underline), colors, rotations, etc. for
(multiple) selected texts.
To create an annotation text object
In a map window, open the File menu and choose Create Annotation Text. You can
also open the Layers menu, choose Add Annotation, Text Layer and then click the
Create button in the appearing Add Annotation Text dialog box.
To display annotation text
The easiest way to display an existing annotation text object in a map window is to
drag the annotation text object from the Catalog to a map window. In a map
window, you can also open the Layers menu and choose Add Annotation, Text
Layer and then select an annotation text object in the appearing Add Annotation
Text dialog box.
To edit annotation text
Annotation text objects can be edited in the Annotation Text editor or in a table
window. In the annotation text editor, you can insert new texts and delete selected
existing texts, move one or more selected texts to another position, make text
duplicates, and specify fonts, sizes, colors, etc. for (multiple) selected texts.
§ When you create a new annotation text object, the annotation text editor is
directly opened.
§ To edit an existing annotation text object in the annotation text editor, first
display the annotation text object in a map window, then open the Edit menu in
the map window, choose Edit Layer and select the annotation text layer.
§ To edit an annotation text object in a table window, you can simply double-click
the annotation text object in the Catalog, or open the File menu in the Main
window, choose Open As Table and select the annotation text object.
For more information, refer to the Annotation Text editor.
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Technical information
An annotation text object consists of an ASCII object definition file (.ATX) and a
binary data file (.AT#). The object definition file contains information on the
working scale and information on columns in the table. The object definition file
contains no further references to other objects.

4.3.2

Simple Annotation

You can add simple annotation to a map window in the form of texts, legends,
boxes, North arrow, scale bar, grid lines, graticule, or bitmaps or metafiles (pictures)
from disk. Furthermore, any picture or bitmap that was copied to the clipboard from
other Windows application programs can be pasted into ILWIS. You can also paste
the contents of another ILWIS map window as annotation into a current map
window; for instance as an inset-map giving an overview of a larger area.
These types of annotation can be edited in the Annotation editor. To store this type
of annotation, you need to save the map window in which they are displayed as a
map view.
F

You can create an Annotation Text object when you want to store multiple texts at
multiple positions. Annotation Text objects are stored as objects and can thus be
added to multiple map windows. Texts in an annotation text object can be edited in
the Annotation Text editor: you can for instance easily move texts, specify fonts,
font size, colors, etc.
Annotation is generally used on top of one or more data layers (displayed maps).
Creating annotation
There are several ways to add annotation to a map window:
§ from the Layers menu, choose Add Annotation, and select the type of annotation
you want, or
§ from the Layers menu, choose Layer Management. In the appearing Layer
Management dialog box click the Add Annotation button, and select the type of
annotation you want, or
§ from the Edit menu, choose Annotation. The Annotation editor is opened
directly.
Before annotation is shown, you have to specify some display options for the
annotation layer. Then, the Annotation editor is opened. In the Annotation editor,
you can use the same possibilities as above, but you can also click one of the add
annotation buttons in the button bar (the status line gives an explanation).
For more information, see also How to add annotation to a map window.
Editing annotation
You can edit annotation in the Annotation editor. To open the Annotation editor,
choose the Annotation command on the Edit menu of a map window. The
Annotation editor is automatically started when a new annotation layer is added to a
map window.
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In the Annotation editor, texts, legends, boxes, scale bar, North arrow, and bitmaps
or pictures can be moved to another position by drag and drop. The size of these
types of annotation can be adjusted by dragging the size handles of a selected object.
Further, the display options of these types of annotation can be changed by doubleclicking. Grid lines and a graticule have a fixed position in a map window according
to the georeference of the map window and can thus not be moved or doubleclicked. You can always change display options of an annotation layer by choosing
the Display Options command from the Layers menu, or through Layer
Management. For more information, refer to the Annotation editor or to How to edit
annotation.

F

To create more space in a map window for annotation, select the Extend Window
command on the Options menu.
Saving annotation
Annotation should be saved with the contents of your map window as a map view.
Either in the Annotation editor or in the map window, open the File menu, and
choose the Save View or the Save View As command. All annotation layers and all
data layers in the map window are stored with their current display settings. Specify
a name for the map view and a title. The title will appear in the title bar when you
redisplay the map view.
Annotation types

Annotation Text object
An Annotation Text object, also called an annotation text layer, is designed to
display and store multiple texts at multiple positions. While other annotation types
can only be stored by saving a map window as a map view, an Annotation Text
object can be stored by itself.
When you create an annotation text object based on an existing map, you can easily
obtain texts for all points, segment or polygons of the selected map. it is advised to
create an Annotation Text object. An Annotation Text object can be edited in the
Annotation Text editor: you can reposition selected texts, specify fonts, font sizes,
appearance (bold, italics, underline), colors, rotations, etc. Texts in an Annotation
Text object can only consist of one line.
For more information, see 4.3.1 ILWIS objects: Annotation Text.
Single text
A single text annotation can be used to display one text at one position in a map
window, for instance a title. Each single text has to be defined in a Display Options Text dialog box. The text may actually consist of multiple text lines; you can use the
Enter key or the Shift+Enter key. Single texts can only be stored by saving a map
window as a map view. Single texts can be rotated, and font and colors are userdefined.
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Legend
Legends are more or less automatically created from the domain that a map is using
and from the representation used by that domain. A legend can be created for maps
using a class domain, the image domain or a value domain.
For a legend of a class map, color boxes and class names appear in principle for all
items in the class domain. The user can hide class names from the legend and
manipulate the order in which class names appear in the legend. Further, font and
text color are user-defined and the legend can be made transparent or not.
For a legend of an image or a value map, a vertical color bar with gradual colors as
used in the displayed map is automatically created. Font and color for the text
explaining some of the colors in the color bar are user-defined, and the legend can
be made transparent or not. See also Display Options - Legend (Image/Value) dialog
box.
North-arrow
A North-arrow points to the North of a map; the North is determined from the
georeference of a map window.
In the Display Options - North Arrow dialog box, you can choose between three
types of North arrows. Furthermore, you can specify the line width and color.
Optionally, text such as N, E, S, W can be displayed with the North arrow. The font
and color for the text is of course user-defined.
Scale bar and scale information
A scale bar and scale information (e.g. 1 : 100000) can be shown based on the
georeference of a map window.
In the Display Options - Scale Bar dialog box, you can choose whether to create a
scale bar as blocks of alternating colors or as a line with tick marks. Furthermore,
you can specify the distance intervals and colors used in the scale bar, and the font
and colors used for the text below the scale bar.
Optionally, you can also obtain scale information. When you display scale
information, the value may seem odd in the map window, however, when you print
the map on a certain scale, the scale value is automatically adjusted to the scale that
you selected for printing.
Box
Boxes can be used to obtain for instance borders around a legend, a title, etc. In the
Display Options - Box dialog box, you can choose between two types of boxes, and
you can select a line type and a color of the borders of the box. When you select line
type Single, you can also specify the line width. By default, the inside of a box is
transparent, but you can also fill a box with a color. You can size a box by dragging
one of the size handles of the box in the Annotation editor.
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To obtain borders exactly around a mapped area, use the Draw Border check box in
the Display Options - Grid Lines dialog box.
Grid lines
Grid lines, coordinate ticks, X- and Y-coordinates and a border fitting a map can be
shown. Grid lines are parallel to the X- and Y-axes of the coordinate system.
When a map window displays:
§ a North-oriented map (e.g. raster map with a georef corners), the grid lines will
be straight and exactly horizontal and vertical;
§ a raster map which has a georef tiepoints with a conformal, affine or projective
transformation, the grid lines will be straight but not exactly horizontal and
vertical;
§ a raster map which has a georef tiepoints with a higher order transformation, or a
georef direct linear, georef orthophoto, the grid lines will be curved.
In the Display Options - Grid Lines dialog box, you can specify the spacing of the
grid lines in meters. Furthermore, you can select a line type and a color for the grid
lines.
X- and Y-coordinates of the grid lines can be shown as text inside or outside the
map area, and can appear in a short form. The font and color used for the coordinate
texts are of course user-defined.
Graticule
A graticule draws parallels and meridians; you require a coordinate system that has
projection information.
In the Display Options - Graticule dialog box, you can specify the spacing of the
graticule in degrees, minutes and seconds. Furthermore, you can specify a line type
and a color for the graticule. Latitudes and Longitudes of the graticule cannot be
shown yet as text.
Bitmaps from disk
A bitmap is a standard Windows graphic file format in 'raster' form. Bitmaps can be
added as annotation to an ILWIS map window. Bitmaps are stored in device
independent bitmap (DIB) format, i.e. bitmaps are not dependent on the graphic
board. Bitmaps can use a 2, 16, 256 color palette, or are stored using 24 bits per
pixel. The default file extension for bitmaps is .BMP.
When using 256 color bitmaps, and when a lot of windows with many colors are
open already, you may loose the colors of pasted bitmaps. When this occurs, you
might consider using 16 color bitmaps.
Windows metafile or pictures from disk
A Windows metafile, often called a picture, is a standard Windows graphic file
format in 'vector' form. Metafiles or pictures can be added as annotation to an
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ILWIS map window. A metafile consists of a set of Windows drawing instructions.
The default extension for Windows metafiles is .WMF.
ILWIS maps as inset-maps in other map windows
Prepare an ILWIS map as usual, copy it into the clipboard and paste as a picture into
another ILWIS map window. The pasted layer is an annotation layer.
Pasting pictures and bitmaps from clipboard
Any picture or bitmap in the clipboard (copied into the clipboard from any Windows
application), can be pasted into an ILWIS map window. You can use the clipboard
viewer in Windows to view what is in the clipboard.
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